ﬁ WGDBY7

WINDOWS DEBUGGER FOR THE ST7 EMULATOR,
SIMULATOR AND DEVELOPMENT KIT

PREFACE

Purpose of the Manual

This manual describes how to configure, start and operate the WGDB7 Windows Debugger, to
debug programs written for the ST7 family of microcontrollers, in any of these development
and test environments:

» Program debugging with ST7 emulators,
* Program debugging with ST7 simulators,

» Program debugging with ST7 development kits.

WGDB7 communicates with the user via the standard Windows Graphical User Interface.

Itis based on the GNU Debugger (GDB) command set, and uses additional ST7-specific com-
mands. Consequently, the manual discusses also basic GDB commands.

Audience

This book is intended for persons who have previous experience using assembler or C lan-
guages, but who are beginners in the ST7 microcontroller field and need to know how to han-
dle related development and test tools.

Related Publications
The following publications contain useful complementary information:

e ST7-Family, Data Sheets |,

o ST7-Family, 8-bit MCUs, Product Overview , Ref. BKST7/2

» Software Tools for the ST7 Family , Ref. Doc-ST7ASMLK-SW

o ST7-Family, Programming Manual

» ST7-Family Development Kit, Getting Started , Ref. Doc-ST7MDTx-DVP
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Organization of the Manual
This manual contains eight chapters:

Chapter 1,
INTRODUCTION,

discusses the con-
cepts of simula-
tion- and emula-
tion-aided debug-

ging.

Chapter 2,
INSTALLING
WGDB?7,

explains how to in-
stall WGDB7 with
simulator or emu-
lator.

Chapter 4,
OPERATING
WGDB?7,

explains how to
use the debugger.

Chapter 3,
PREPARING PRO-
GRAMS FOR DE-
BUGGING

is a general discus-
sion on source pro-
gram origin.

Chapter 5,
CUSTOMISING
WGDB?7,

explains how to tai-
lor WGDB?7 to you
own needs.

Chapter 6,
WORKING WITH
WORKSPACES,

is devoted to pro-
gram  workspace
management.

Chapter 7,

USING GDB7
COMMANDS, pro-
vides information
on GDB7 com-
mands that can be
used with WGDBY7.

Chapter 8,
QUESTIONS
AND ANSWERS,

answers some
general questions
about WGDB7 op-
eration.
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1 INTRODUCTION

1.1 An ST7-Family Debugging Tool

WGDBY7 is a debugger for programs developed for the ST7 family of microcontrollers and
based on either the STMicroelectronics ST7 Macro-Assembler and linker ASM/LYN or the Hi-
ware ST7 C Toolchain.

WGDBY7 runs under Windows 3.x™, Windows 95™ or Windows NT ™,

1.2 Emulators, Simulators, Development Kits

You can use WGDB?7 with either of the following device:
» ST7 Emulator,

» ST7 Simulator,

» ST7 Development Kit.

~ N 5
In the following, the icons @ g!’ and M will be used to point out topics relat-

ed to features specific to emulators, simulators and development kits, respectively.

The ST7 HDS2 Emulator is a hardware device that behaves like an actual ST7 microcontrol-
ler and provides real-time execution of ST7 programs.

The emulator can be connected to your own board, enabling you to emulate the target appli-
cation hardware and software.

The following diagram summarizes the ST7 HDS2 Emulator operating configurations:

LPT1/LPT2 @ ST7XXX Pr/obe

HDS2 D “ User

Emulator Flat Cable III ggglrigation
i

4
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The ST7 Simulator is a program that simulates the execution of ST7 programs, instruction
by instruction. The behaviour of the peripherals is also simulated.

The following diagram shows the WGDB7 simulator operating configuration:

You may see that, in this case, no external hardware is required. This is the major difference
between the debugging methods presently available: using a simulator or an emulator.

A Development Kit is an assembly of hardware and software components that combines de-
velopment, debugging and chip-programming functions. It covers an extensive development
and test field.

The Development Kit board is connected through a parallel port interface to a PC used to
monitor debugging and device programming operations.

The following diagram summarizes the Development Kit operating configurations:

LPTL/LPT2 ST7XXX Probe

Development ?IEDII User' '
Kit Flat Cable III ggglrlgatlon

For more information on a particular Development Kit, see the appropriate ST7 Family, De-
velopment Kit, User Manual .
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Simulation-aided debugging lets you develop and test your application(s) long before your
hardware is finished or available. This could save time and provide you with some comfort re-
garding your own application development plans. Also, this debugging method relieves you
from any premature, undesirable, hardware dependency. Lastly, this is the cheapest solution.

Some real-time debugging features such as the tracing facility and the logic analyser function
are not available, however. Nevertheless, you will benefit from new other features such as
time measurement, and time-dependent break management.

Emulation-aided debugging lets you also develop and test your application(s) long before
your hardware is finished or available. Although it is more hardware-dependent than the sim-
ulation option, because emulators have components specific to various microcontroller fami-
lies, it presents the major advantage of supporting real-time testing and debugging in the user
application board environment. Also, it supports the tracing and logic analyser debugging fea-
tures that can be used in conjunction with the emulators.

The Development Kit and the Emulator debugging capabilities are very close. Compared
with the Simulator and the Emulator, the Development Kit shows some differences, however,
summarized in the table “WGDB7 Debugging Features for the Development Kit, Emulator and
Simulator” on page 9

1.3 WGDB7 Main Features
1.3.1 Displaying Data
WGDBY7 can display data in either ‘normal’ or ‘hot’ mode.

In normal display mode , data is displayed as it was when you chose to view it, and it is not
automatically updated. Data is displayed on a white background.

In hot display mode , data is updated every time the execution of the program you are debug-
ging is suspended, and is displayed on a yellow background.

1.3.2 Entering Data

When you operate WGDB7, you enter data in standard Windows dialog boxes. In some cas-
es, you'll notice that when you update fields, the field name is highlighted in red. This indicates
that you have changed a value but the changes have not yet been implemented by the emu-
lator or simulator. You must press the Enter key when the cursor is on that field to implement
the changes you made.
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1.3.3 Workspaces

WGDB7 enables you to save and load workspaces. Workspaces are snapshots of windows
and option choices that are taken when you close a program. Each program you debug using
WGDBY7 has its own default workspace definition. When you load a program, the workspace
that you were using when you last closed it is restored, thus you can continue working from
where you left off. You can also save workspace definitions at any time, so that you can re-
store them at a later date. See “Working with Workspaces” on page 64 for further details.

1.3.4 Using GDB Commands

You can execute general purpose GNU and ST7-specific debugging commands through a
command line interface, via the Console option in the main menu, so that you can use the
commands that are not built into the WGDB7 Windows interface.

1.3.5 WGDB7 Debugging Capabilities

WGDB7 enables you to execute ST7 programs, and view the contents of the ST7 data and
program memory as the program progresses. You can examine source code, as you would
with a C-language source program, and assembler code. Program execution history can be
viewed at source or instruction level. WGDB7 lets you read and write all ST7 registers and
memory locations.

The debugging capabilities of WGDB7 depends on which version of the debugger is imple-
mented: WGDB7 with Emulator or Simulator.

Differences are summarized below in Table 1, “WGDB7 Debugging Features for the Develop-
ment Kit, Emulator and Simulator,” on page 9.

As a general rule, WGDBY7:

* Enables you to execute source code and machine code line by line. A function call can
optionally be considered as a single instruction, depending on the level of detail required.

* Lets you set software breakpoints on source or disassembled code, that stop the program
running when a chosen instruction is reached.

* Lets you set hardware breakpoints, which either stop the program running when a pre-
defined area of memory is accessed or send a signal to the output triggers (only with emu-
lators and development kits in the later case).

» Enables you to view and modify the simulated/emulated ST7 memory and register con-
tents.

» Enables you to view and modify assembly symbols or C-language variables in their type-
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defined format with possible display options such as binary, decimal or hexadecimal.

» Enables you to view the stack contents.

» Enables you to write small programs or modify them at assembly mnemonic level, using

the Online Assembler feature.

» Automatically executes GDB7 command batch files, with or without the WGDB7 graphical

interface, at start-up.

» Enables you to quickly switch from a target debugging mode to the other, for example from
the simulator to the emulator, maintaining all workspace context information such as win-

dows position, software breakpoints, etc.

The features supported by WGDB7 when running with an emulator, a simulator or a develop-

ment kit are summarized in the following table:

Table 1. WGDB7 Debugging Features for the Development Kit, Emulator and Simulator

Debugger Debugger Debugger
+DEVKIT +EMU +SIMU
Description
~
L]
Y
Hardware Test YES YES NO
Loading Programs, Viewing Program Details YES YES YES
Executing Loaded Programs YES YES YES
Managing Software Breakpoints YES YES YES
Managing Hardware Breakpoints YES YES YES
Viewing ST7 Resources YES YES YES
Viewing Disassembled Program Code YES YES YES
Viewing Register Contents YES YES YES
Watching Symbols, Types of Variables, Expressions YES YES YES
KY[ 9/76
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Table 1. WGDB7 Debugging Features for the Development Kit, Emulator and Simulator

Debugger Debugger Debugger
+DEVKIT +EMU +SIMU
Description

kAR
I\E/Ir;t;r(i)r;)g/], Assembling Mnemonics to Emu /Simu ST7 YES YES YES
Using GDB7 Commands YES YES YES
Choosing Emulated/Simulated ST7 Micro Name YES YES YES
Changing ST7 Emulated/Simulated Memory Mapping YES YES YES
Displaying and Modifying Configuration Options YES YES YES
Customising the Debugger YES YES YES
Working with Trace Buffer NO YES NO
Accessing Logic Analyser Information NO YES NO
Simulating Pin Input/Output Signals n.a. n.a. YES
Time Management NO NO YES
Output Trigger Management YES YES NO
Stack Overflow/Underflow Stop YES NO NO
Non-existent Memory Stop YES NO NO
Write Protect Memory Stop YES NO NO
Input Trigger Stop YES NO NO
10/76 ‘7_[
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2 INSTALLING WGDB7

2.1 Hardware and Software Requirements

To run WGDB?7, you must have the following hardware and software:
* A PC with a 386 or higher processor

» Atleast 5 Mbytes hard disk space

* At least 4 Mbytes RAM

» Microsoft Windows 3.1x, Windows 95 or Windows NT

» For Emulators and Development Kits: Your PC parallel port must have been configured as
an output-only type port. WGDB7 does not support EPP, ECP or bi-directional parallel port
configurations.

2.2 Compatibility

WGDBY7 is compatible with all families of Development Kits and ST7 HDS2 emula-
@ tors.

2.3 Basic Installation Procedure

To install WGDB?7, follow these steps:
1 |Insert the delivery CD-ROM into your CD-ROM drive.
2 Using Windows Explorer, open the root directory of your CDROM drive
3 Find the St7tools  sub-directory in the CDROM and run
St7tools\disk1l\setup.exe

to start the installation program.
4 Follow the installation instructions. You may:

» change the destination folder (c:\St7tools by default),

» choose to install only a selection of the software components, to spare disk space,

» specify the connection port name, LPT1 or LPT2 (LPT1 by default) for emulators and
development Kits.

4
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2.4 Installing WGDBY7 in the Windows NT Environment: Completing the Installation

If you are installing WGDB7 on a Windows NT platform, and you want to use WGDB7 with an
HDS Emulator or a Development Kit over a parallel port, you must install the genport.sys
parallel port driver that is supplied in the diskette labelled “NT Driver Installation” included in
the delivery package.

For this, you must have the Windows NT system administrator’s rights.

To start the installation of the driver, run the setup.exe installation program in the supplied
diskette and follow the instructions.

2.5 Powering Up the Emulator

2.5.1 Connecting the Emulator

@ To connect your emulator to your PC.

1 Connect the parallel cable of the emulator to the LPT1 or LPT2 parallel port of your PC,
2 Switch on the emulator,

3 Start WGDBY7 by following the instructions given in “Starting WGDB7” on page 18.

Look at the emulator front panel: a red LED should be turned on indicating that WGDB?7 is
communicating with the emulator.

By default, when you start WGDB?7 in this environment, the emulator program memory is set
to undefined values.

2.5.2 Running the Hardware Test

The hardware test lets you check that your emulator is correctly connected, config-
@ ured and working.

You can test components of the emulator individually or all at the same time.
To run the hardware test:

1 Run WGDBY.

g
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2 Onthe Commands menu, click Hardware Test .
The Hardware Test dialog box opens.

3 Select the components you want to test from the list, by clicking the appropriate check box-
es. When a box is checked, its component is tested.

4 Click the Test button to start the test.

Once the test has been performed, the results are displayed in the Hardware Test dialog box:

4 Check Device board Ok
[] Check Halt and Reset emulator Mot tested
[] Check Write protect request Mot tested
£ Check Mext request Ok

[] Check 5A breakpoint request Mot tested
[] Check Logical analyser request Mot tested
£ Check Logical analyser data recorded request  Error

Cloze

NOTE: In case of test failure, contact your local support representative.

Click the Close button to close the Hardware Test dialog box. You are directed to the WGDB7
main window.

2.5.3 Connection Troubleshooting

@ The following messages may be displayed when you start WGDB7 with an emula-
tor:

Message:

Check that the emulator is switched on
and the parallel cable is properly connected

Meaning:

172 13/76
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No connection has been established between the emulator and your PC.
Action:
1 Exit WGDB7
2 Check the following:
i Your emulator is switched on,

il You switched on the emulator after switching on your PC. If you switched on the emu-
lator before switching on your PC, switch the emulator off then on again.

iii  The cable is correctly connected to your PC.

Message:

No message received from the emulator

Meaning:
Configuration problem.
Actions:

» If you are running an HDS2 emulator on a Windows NT platform, check that you have cor-
rectly installed the Windows NT driver that is supplied on the diskette labelled “NT Driver
Installation Diskette”.

» Check that your PC parallel port has been configured as an output-only parallel type port
(BIOS settings). WGDB7 does not support EPP, ECP or bi-directional parallel port configu-
rations.

2.6 Powering Up the Development Kit
2.6.1 Connecting the Development Kit

0
V1
N

= Proceed as follows:

1 Connect the evaluation board (P2 connector) to the parallel port (LPT1 or LPT2) of your
PC via the appropriate cable.
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NOTE: The supplied interface cable has been tested in order to operate properly on most
PCs. Do not use any other cable, especially if it is longer than the one provided by
STMicroelectronics: the board may not operate properly.

The cable should be connected directly to the DB-25 female connector of the PC par-
allel port. This connector is similar to the one installed on the board. Do not insert any
additional cables or switchboxes between the PC and the board: a malfunctioning of
the board may result.

2 If necessary, connect the probe (P3 connector) using the flat cable that has been supplied
in the package.

3 Power up the board.

NOTE: To avoid risks of short circuits, first connect the plug-in power supply pack jack into
the P1 female jack connector on the board, then plug the power supply pack into the
mains AC outlet.

If the board is fed via the complementary two-point connector make sure that the right
feeders lead to the right polarities.

The green POWER LED lights up.

2.6.2 Running the Hardware Test

.~ The hardware test lets you check that the evaluation board is correctly connected,
N . .
(__/ configured and working.

To run the hardware test:

1 Run WGDBY7.

2 On the Commands menu, click Hardware Test .
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The components of the development kit are tested one after the other

During the tests the following message box is displayed:

Hardware Test E

Hardware Test in progress

Pleaze wait __.

Upon successful completion of the tests the following message box appears:

Hardware Test Rezult |

Hardware Test Ql

NOTE: In case of test failure, contact your local support representative.

Click OK to close the Hardware Test Result message box.

16/76
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3 PREPARING PROGRAMS FOR DEBUGGING

You can debug programs that were generated using either the STMicroelectronics ST7 Mac-
ro-Assembler or the Hiware ST7 toolchain.

In both cases, make sure that the Reset Vector is correctly initialised, so that the Run and Re-
set commands operate correctly.

Some example macro-assembler source programs are provided in the Sample subdirectory
of the WGDBY7 installation directory.

To be able to load a program, WGDB7 must have access to the *.s19 file in the Srecord for-
mat or the .abs file for the Hiware ST7 toolchain.

From the *.s19 file, WGDB7 can obtain the symbol files that were generated by the toolchain.
For the STMicroelectronics ST7 Macro-Assembler, symbol files include .MAP. and .LST files.

To generate the correct files for WGDB7, when you assemble programs using the STMicroe-
lectronics ST7 Macro-Assembler, you must use the following options:

asm -li macrost7.asm -- assemble with listing(*)

lyn macrost7.obj,macrost7 -- link and generate map

asm macrost7.asm -sym -fi=macrost7.map -- update the listing with symbols(*)
obsend macrost7,f,macrost7.s19,srec -- generate srec code

or:

obsend macrost7,f,macrost7.hex,intel -- or generate intel hex code

(*) to be repeated for each module linked in the application.

Make sure that you use the STMicroelectronics ST7 Macro-assembler version pack 8 or later.

If no symbol file is provided with the .s19 or .hex file, you can still perform some debugging
tasks, such as viewing ST7 memory contents, viewing disassembled code, displaying and
modifying register values, executing programs and viewing trace buffer contents (not applica-
ble in the later case for simulators).

For the ST7 C compiler, refer to the compiler documentation for information on how to gener-
ate debug information.

For more information on Assembler directives, see “Software Tools for the ST7 Family”.
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4 OPERATING WGDB7

4.1 Introduction

This section describes how to perform the basic tasks that you will typically carry out when you
debug a program using WGDB?7. It aims to get you quickly started with WGDB?7. For detailed
information about windows, menus and dialog boxes, and on how to perform all tasks, use the
WGDBY7 online help (see “Getting Help” on page 19).

4.2 Starting WGDB7
The WGDB7 debugger is installed in the installation root directory. By default, you will find it in:

C:\St7tools

To start WGDBY7, just click the appropriate icon (or name in the cascading menus) in the Win-
dows desktop.

Depending on which tool you installed, you may find icons (or names) for:
WGDB7 Emulator
WGDB7 Development Kit
WGDB7 Simulator

The WGDBY7 Introductory window appears (simulator example):

About WGDB7 |

WGDBY Beta 2.2 June 12,1998

Pleaze wait while connecting

& with the simulator ...

@ STHicroelectronics, 1998.

Free System Resources: 61 %
Current Time: 10:47:15
M emory: 32264 KB Free

4
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The debugging session starts a few seconds later.

To get accustomed to the product, you may start one of the sample programs provided with
the package, via the File/Open debugger menu chain.

The sample programs can be found in:
C:\<install folder>\sample

where <install folder> is the installation root folder (directory), St7tools by default.

Once WGDBY7 starts, the main window opens (simulator example):

The Title bar will later display the name of the program that is currently loaded (see “Loading
Title bar

Menu bar

[EYST72101G1 Simulator

Eile ‘Windows Commands Sources Help
Bun I Cont I Mext I Step I Finizh I

™~ 4

Program execution buttons

a Program” on page 29).

The Menu bar displays the available menus. Clicking a menu name opens it. Since no pro-
gram is loaded, all program-related menus are greyed out and thus cannot be accessed.

The program execution buttons provide you with quick access to the program execution func-
tions. See “Executing Loaded Programs” on page 35.

NOTE: All the task procedures described in this book start from the main window.

4.3 Getting Help

WGDB7 enables you to access two types of help messages:

» Task-based help, where you choose a task about which you want information.

» Context-sensitive help, that displays information about the window or dialog box that is cur-
rently active.
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To access task-based help:
1 From the Help menu in the main window click Contents.

2 Click the task about which you want further information.

To access context-sensitive help on the window or dialog box that is currently active:

1 On the window or dialog box, click the Help button if there is one, otherwise click the [F1]
key.

A help window opens displaying the window or dialog box that is currently active.

2 In the help window, click on the item, such as a menu name or field, about which you want
further information.

4.4 Emulator/Simulator Configuration Options

Once you have started the debugger, even if you have not yet loaded a program, you can view
and configure some emulator/simulator-specific settings.

These are:
* The ST7 micro name that is being emulated or simulated.

» The emulated/simulated ST7 memory mapping.

Other emulator configuration options, such as the clock speed. The configurable options
depend on the emulator family you are using. Refer to the documentation provided with
your ST7 HDS emulator for further details.

When you close an application, a configuration file (<application>.CF7 ) that con-
tains memory mapping information is automatically generated. The definitions
stored in this file are restored when reloading the application. This configuration file
includes the micro name, the memory configuration, micro configuration and the
trace analyser settings. When WGDB?7 is used with a simulator, this information is
saved in the application workspace.

SN

4.4.1 Choosing the Emulated/Simulated ST7 Microcontroller
1 Onthe Commands menu, click Micro Nam e.

The name of the ST7 that is currently being emulated/simulated is displayed in the Micro
Name dialog box
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. Micro Hame !EIE
Current Micro : ST7210G1 j
677210162 T
Ok | ST7A12102 —]
—IST7A121J4
ST72213G1 —
ST721120G2
ST72311.2
ST7231104 bl

2 To choose another ST7 , select the appropriate name from the drop down list. Click OK.

The emulator/simulator is now configured for the selected ST7 microcontroller.

4.4.2 Changing the Emulated/Simulated ST7 Memory Mapping
1 Onthe Commands menu, click Memory Configuration

The Memory Configuration dialog box opens, displaying the defined memory mapping
for the emulated/simulated ST7:

WGDB?7 with Simulator:
2To modify or create a mapped area, click the Modify button. The New/Modify

]|

~
LY

Memory Configuration

" Current M apping
0000 - D07F : PERIPHERBALS

Map window opens:

(574

0080 - 013F
0140 - 017F
0180 - EFFF
FOOO - FFDF
FFED - FFFF

: RAM

: STACK

: RESERVED
: EPR

: YVECTOHS

M odify

Memory Check X

Help Cloze
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3 Next, enter in the appropriate fields the Start and End address of the memory area you

Memory Configuration |

" Current Mapping " Modify Area

0000 - 007F : PERIPHEBALS
0080 - 013F - RAM Start address : Ox E

0140 - 017F : STACK
0180 - EFFF : RESERVED

FOOO - FFDF : EPR End address : ux
FFED - FFFF : VECTORS
Area type : Mj

Memory Check [¥

M odify | Help | Cloze Ok | Eant:ell Apply

want to define/modify.

4 From the Area type combo box, select the type of memory for the above area: Peripher-
als, Stack, RAM, ROM, Vectors, or Reserved.

5 Click Apply to implement each creation/change.
6 Click the OK button to confirm the changes.

The new or modified memory area is now mapped.

¢ WGDBY with Emulator or Development Kit:

N

7

,\\g

A
SN
\
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4

7 To modify a mapped area, select the area and click the Modify button.

Menory Configuration 3|
Current micro : 5T72101G1
0000 - 0002 : PERIPH
0003 - 0003 : RESERYED
0004 - 0006 : PERIPH
0007 - 0007 : RESERYED
0008 - 00DA : PERIPH
0ODO0OB - 0O01F : RESERVED
0020 - 0024 : PERIPH
0025 - 0030 : RESERYED
0031 - 003F : PERIPH
0040 - 007F : RESERVED
0080 - 013F : BAM
0140 - 017F : STACK
0180 - EFFF : RESERYED
FOOD - F200 : RAM
F201 - FFF1 : BOM
FFF2 - FFF5 : ¥YECTORS
FFFG - FFF¥ : BOM
FFF8 - FFFF : YECTORS
Modify Mew Area Cloze

To create a new area, click the New Area button.

The New/Modify Map window opens:

4
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NEwMAP |

FO00

first address of the area

lazt addresz of the area 200

map type Mj

1].4 Cancel |

8 Next, enter in the appropriate fields the First and Last addres s of the memory area you
want to define/modify.

9 From the Map type combo box, select the type of memory for the above area: Peripher-
als, Stack, RAM, ROM, Vectors, or Reserved.

10 Click the OK button to confirm the changes.

The new or modified memory area is now mapped.

4.4.3 Viewing and Setting Additional Emulator Configuration Options
1 On the Commands menu, click Micro Configuration

The configuration options available for the currently installed emulator or simulator are
displayed.

The options that you can configure depends on the current debugging mode (with simula-
tor, emulator or development kit).

This causes one of the following windows to open:

g
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. WGDB7 with Simulator:
ﬁ" Micro Configuration |
=
_ Watch Dog :
2Select the feature you want to reconfig- @ Software

ure (' Hardware
You may:
 Specify whether the watchdog function is hard- Frequency in kHz: 8000

ware- or software-driven.
] Ok | Help | Cancel

» Select a new clock frequency for the microcon-

troller.

Click OK to confirm.

WGDB7 with Emulator or Development Kit:

<

IS 7> 2 Select the feature you want to reconfigure from the list, then click the Modify but-
\‘{\-‘// ton.

New dialog boxes appear for you to se-

Micro Configuration | lect a new setting for the selected fea-

Current micro : ST72101G1 ture.

CLOCK : INTERNAL _
TIMER A - DISABLED The lists of the features that can be con-

figured depends on the hardware in use
with the debugger (emulator or develop-
ment kit) and on the microcontroller cur-
rently selected (via the Micro Name di-
alog box).

For more information on available fea-
tures, refer to the appropriate emulator
or development kit user manual.

Modify Cloze

4
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When you close an application, the micro definition settings are stored in the file <applica-
tion>.CF7 . The settings stored in this file are automatically reinstated when you load the ap-
plication.

4.5 Viewing ST7 Resources

Once you have started the debugger, even if you have not yet loaded a program, you can view
the contents of the ST7 memory and registers.

The information you can view includes:
* Memory contents
* Register contents

» Disassembled program code that is currently loaded in the ST7 emulator/simulator mem-
ory

4.5.1 Viewing ST7 Memory Contents

To view the contents of the ST7 memory:

1 Onthe Windows menu, click Dump.
2 The Dump window now opens, displaying the contents of the ST7 memory:

Note that before you have loaded a program, the ST7 program memory will be set to O.

. . dump =] E3

Display  Help!
[ Hot Refresh| Address {0x01c0 =

0fc0: 00.00.00.00.00.00,00.00.00,00.00,00.00.00,00.00 @ ... ... ........ ﬂ
gido: 00,.00,00,00,00,00,00,00,00,00,00,00,00,00,00,00 ... ............
0fe0: 00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00 ... ............ J
gfto: 00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00 ... .............
1000: Sb,cc,14,78,00,00,11,05,00,00,00,00,00,££,00,01 L= . .,..... V..

1040: 00,06.01,26,10,6c,10,d8,00,00,00,01,00,02,00,03 R N
1050: 00,.61,00,62,00,65,00,64,00,00,00,00,00,01,01,54 abocd ... .. |
1060 88,.00,0%,00,65,5a,5c, 5=, 60,62,00,00,52,57,45, 54 oeEn kL QWET

1070: G5,59 .54 59 55,47 47, 45,48,47 45,48, 47, 4a,48.53 UYTYUGGIHGIHGIHS j
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From the Dump window, you can perform the following operations:

To do this:

Do this:

Display the memory contents in a different
format

Choose another format from the Display
menu.

Make the window Hot (so its contents are
updated each time program execution is
stopped)

Click the Hot checkbox (the window
background becomes yellow indicating that
the window is hot).

Display contents starting from a selected
address

Enter the address you want to view in the
Address field, then press the Enter key.

Display contents starting from a symbol name

Enter the symbol name or any valid C

expression in the Address field.

NOTE: Setting this window as Hot can reduce the execution speed of WGDB7. You can save
time by not setting this screen as hot, and updating the display when required using

t

he Refresh button.

4.5.2 Viewing Disassembled Program Code

To view the disassembled program code that is loaded in memory:

1 On the Windows menu, click Disassembler .

2 The Disassembler window opens:

The Disassembler window shows each line of source code followed by its disassembled code.

~ Digassembler [ (3] =]

Misc. Edit Commands Help

Break | GoTo |1nspet:l| Nexti | Stepi | |UH131E

0xzl3le BY69 LD 0x69. A LD po.A ;I

0x1318 &4 POP A POP A

0x1319 &1 RET RET

AT

0xl3la CD1:ZFF CALT 0OmlZ2ff CALL InitPtr=

0xl13ld 9093 LD ¥, X LD ¥, X

0xl13lf 2COE JENH 0=xl132f JENH 0=l132f

0xl1321 3ICed IHC Nx64 IHC pl

0xl1323 3JCeS IHC Nxz65 IHC pl

0x1325 3ICe6 IHC =66 IHC pé

0=xl1327 85 POP pid POP bt

0xl1328 BFL6 LD N=x56, X LD _return IR X

0xl3iZa 85 POP pid POP bt

0xzl3Zb BFL7 LD 0x57 X LD 0=57 X ;I
From the Disassembler window, you can perform the following operations:
KY[ 27176
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To do this:

Do this:

Set or cancel a breakpoint on a line

Select the line then click the Break button.

Display the memory contents in a different
format

Choose another format from the Options
command in the Misc. menu.

View more detailed information about a
selected symbol

Select the symbol then click the Inspect
button.

Display the contents starting from a selected
address

Enter a symbol name or any valid C
expression in the Address field, and press
the Enter key on your keyboard.

Insert assembler instructions into emulated/
simulated ST7 memory

Select the Online Assembler
Commands menu.

option in the

Run the program with start/stop conditions

Select Continue , Run, Reset, Stepi, Nexti,
Goto Line , Finish Subroutine options inthe
Commands menu.

4.5.3 Viewing Register Contents

You can view and modify register contents using WGDB7:

1 Onthe Windows menu, click Registers .

2 The Registers window now opens:

Registers |
" Program Counter | Stacks Accumulator |
PC |0ur2f7 ‘ {SP 001 fb { 4
" Index registers Condition Flags
o3 | ¥ (0«39 | {I‘H @l CH[Z XC

3 To modify the value held in a displayed register, overtype the displayed value then press
the Enter key.

The table below describes the fields in the Registers window:

28/76
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This field: Displays this:

Program The Program Counter (PC) register value. This is a 16-bit register that stores
Counter the address of the next instruction to be executed.

Stacks The Stack Pointer (SP) value. This value points to the next free stack location.

Accumulator

The Accumulator (A). This is an 8-bit general purpose register used to hold
operands and the results of arithmetic and logic calculations as well as data
manipulations.

Index The Indirect Registers (X and Y) are used during register-indirect addressing
Registers mode as pointers to memory locations in the memory space.
Flags H is the Half Carry Flag. The H bit is set when a carry occurs between the bit

3 and 4 of the ALU during an ADD or ADC instruction. The H bit is useful in
BCD arithmetic subroutines.

| is the Interrupt Mode Flag, which indicate whether or not the ST7 is in
interrupt mode.

N is the Negative Flag. When set, this bit indicates that the result of the last
arithmetic, logical or data manipulation is negative (i.e. the most significant bit
is set).

The zero (Z) flag is set when the result of the last arithmetic or logic operation
is zero, otherwise it is cleared. The carry (C) flag is set when a carry or borrow
occurs during arithmetic operations, otherwise it is cleared.

4.6 Loading a Program

When you load a program, you must specify the .s19 file (ST7 assembly chain executable) or
.abs file (Hiware tool chain executable) of the program to be loaded. The symbols are auto-
matically loaded from the appropriate symbol file. For details on the file types that you can de-
bug, see “Preparing Programs for Debugging” on page 17. You may also load such files as:

.in files, for pin input simulation files (See “Pin Input/Output Simulation” on page 53),

.gdb files, for GDB command files (See “Using GDB7 Commands” on page 66).

1 On the File menu, click Open.

The Choose a File dialog box opens:

4
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2 Inthe drive list, click the drive that contains the program.

Choose A File =]

Filter: |= abs:*.219:=.gdb:".in
= diy oK

= st7too™1 zample. abs
Cancel
c =1
£ realtim Help
1 spim11 _==r |

3 Inthe box beneath the drive list, double-click the name of the folder that contains the pro-
gram. Continue double-clicking subfolders until you open the subfolder that contains the
program.

4 In the list of files, click the program name.

5 Click OK.

When you load a program, a reset is implicitly performed. To open the Disassembler or mod-
ule window at the current PC position, on the Command menu: click Display PC or click the
Reset button.

TIP: To open a program you've used recently, click its name at the bottom of the File
menu.

4.7 Viewing Program Information

4.7.1 Viewing a Source Module

To view a source module:

1 Open the Sources menu.

4
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2 Either:

Click Modules List... then click the module you want to open.

or

Click the module you want to open from the list.

The module window opens displaying the module you just opened:

From the module window, you can perform the following operations:

“ gamplel_c _ O] x|

Misc. “iew Commands Search Help

Break GoTo Inspect MNext Step ||'| 12 J
07 int court, |; -
M08 shuct toto zzz2;

109 struct boto H;

110 void “zpt;

111

12 fiar [j=0;j++] £ loop for ever 5

113 {

114 sti++;

115 F200 = 0:78;

116 R201 = 0:12;

117 RR200 = Oxfede; v
To do this: Do this:

View further details about any item displayed
in the window.

Click the item then click the Inspect button.

View a line of code disassembled.

Click the line number, then click the Inspect
button.

Step or go to another part of the loaded
program.

Click the appropriate button: Next, Step or
Goto.

Find a character string within the module.

Click Find on the Search menu.

Insert a software breakpoint.

Click where you want to insert the breakpoint,
then click the Break button, or click on the
break bar to the left of the window next to the

line on which you want to set the breakpoint.

4
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4.7.2 Finding and Viewing Symbols

To find symbols and view detailed information about them:

1 On the Windows menu, click Browser .

The Browser window opens:

2 In the Symbol Selection box:

32/76

Select the symbol type you want to find from the Type drop-down list.

=% Browser [_ =]

" Symbol Selection

Tyve AR~ Apoly
Module |[A|I] j|
Filter = j| [ Clean list

10 Symbols matching

__ImitDataBsgs -

glop

main
e
testchar

testint

testlong b

__Reset —

Symbol Details

File sample3.c: int my_lkib{):

Close | Help | Inspect | Add To Watch

Select the module that contains the symbol you want to find from the Module drop-

down list.

Check the Clean list checkbox if you want to prevent found symbols from appearing

more than once if they are included in more than one module.

Enter the search operators in the Filter field:

To find:

Use this operator: Examples:

All names

*

a substring

Allthe names containing | The substring

and “bat”.

“at” finds “data”, “date”

4
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To find: Use this operator: Examples:

All the names starting ~ the substring “ba” finds “batch” and
with a substring “back”

All the names ending the substring $ “de$” finds “node” and
with a substring “side”

v Click the Apply button.

6 The Symbols matching box lists the symbols found using the selection criteria entered in
the Symbol Selection box.

7 You can now view further details about the found symbol by:
i Clicking the symbol and viewing the Symbol details box.

i Clicking the symbol then clicking the Inspect button. If you selected a function, the
function body is displayed in either the Disassembler window (see “Viewing Disassem-
bled Program Code” on page 27) or the Module window (see “Viewing a Source Mod-
ule” on page 30), depending on the available source file types. If you selected data or
a constant, its value and type are displayed in the Inspect window.

ili  Clicking the symbol then clicking the Add To Watch button to see its type and value in
the Watch window (see below).

4.7.3 Watching Variable or Expression Values

WGDB7 enables you to watch the values of variables or expressions, which are updated each
time program execution is suspended (for example, after a next or step instruction). To view a
variable or expression value in the Watch window:

1 Either:

Select the variable whose value you want to watch in the Browser window, then click the
Add to Watch button.

or:

On the Windows menu, click Watch, then type the name of the expression you want to
watch in the expression box then press Enter.

The Watch window now opens, displaying the value of the selected variable:

33/76
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From the Watch window, you can perform the following operations:
Sort by drop-down

34/76

Expression box

list

=+ watch

Actions  Display  Help!

Add | Delete | [T | [RR200 |

zanplel .o 0=l26 struct {.. .} gamma {
pt=2848.
u=L,
v=h

: _ 1

zanplel .o 0=x184 unzigned char cdata 137

zanplel .o 0=81 int EEZ00 —-292

To do this: Do this:

Change the format in which newly displayed
symbols are displayed.

Choose the appropriate option from the
Preferences submenu onthe Display menu.

Choose the information you want to display
(address, module, type).

Choose the appropriate option from the
Format submenu on the Display menu.

Change the base in which the value of the
selected symbol is displayed.

Choose the appropriate option from the Base
submenu on the Display menu.

Choose the symbol type that data is sorted
by.

Select the symbol type from the Sort by drop-
down list.

View the value of an expression.

Enter an expression in the expression field.

View a range of n bytes starting from a
variable or an address.

Enter the variable name or the address,
preceded by a * and followed by @n in the
expression box.

For example, to view the 5 bytes starting at
address 0x4003, enter: *0x4003@5.

View a subrange of nvalues of an array.

Enter * followed by the array or pointer name
followed by @n in the expression field.

View a selected function disassembled.

Select the function, then click Disassembler
on the Actions menu.

View and modify the data held in memory for
a selected symbol.

Select the symbol, then click Dump on the
Actions menu.

View a value of the selected symbol in the
Inspect window.

Select the symbol, then click Inspect on the
Actions menu.

View a selected function within the source
code.

Select the symbol, then click Sources on the
Actions menu.

Change the value of a symbol.

Click on the value and overtype it.

4
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Add a symbol or expression to the Watch Click the Add button. A secondary window
window, so it can be viewed along with other | opens where you can select a symbol or an
symbols and expressions as their values expression. Confirm by clicking OK in this
progress. new window.

Remove a line from the Watch list Select the line and click the Delete button.

4.8 Executing Loaded Programs

WGDB?7 includes the following program execution commands, which are available either as
buttons in the main window or other windows (where appropriate) or on the Commands

menu.

The following table explains what each command does:

This command: Does this:

Run Resets the emulator, and runs the program from the reset starting
point until a breakpoint is reached.

Cont Continues running the program from the current PC until a
breakpoint is reached.

Next Executes the source line at the current PC location, stepping over
any function calls.

Step Executes the source line atthe current PC location, stepping into any
function calls.

Finish Runs the program from the current PC line until the end of the
current function is reached, then returns to the calling procedure.

Stop Stops the program running.

Reset Resets the ST7 emulator. The PC is set to the reset vector value and
A, X,andY are setto O (see “Viewing Register Contents” on page 28
for further details about these values).

Goto Runs the program from the current PC position to the specified
marker position.

Stepi Steps one instruction immediately following the PC line, stepping
inside any call instructions.

Nexti Steps one instruction immediately following the PC line, executing
any call instructions.

TIP: To execute a program from a specific address, set the PC value to where you want to
start running the program in the Register window (see “Viewing Register Contents” on
page 28), then click the Cont button.

4
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4.9 Using Software Breakpoints
4.9.1 Setting Software Breakpoints

Software breakpoints are breakpoints that are triggered when a source line or a disassembled
instruction is executed.

You set software breakpoints in either the module window or the Disassembler window.

To open the module window, click the Source menu, then click the name of the source mod-
ule in which you want to set a breakpoint. To open the Disassembler window, on the Windows
menu, click Disassembler .

In the module or disassembler window:

either:

1 Click the line of code on which you want to set a breakpoint.
2 Click the break button.

or:

Click on the break bar on the left side of the window next to the line on which you want to set
the breakpoint.

A breakpoint is now set on the selected line. This line is highlighted in bold (by default), indi-
cating that it includes a breakpoint.

NOTE: If you try to place a breakpoint on an inappropriate line, such as on a While condition
or a comment, WGDB7 will set the breakpoint on the next available line.
4.9.2 Managing Software Breakpoints

You can perform all software breakpoint management tasks in the BreakPoints List window.
Note that this is only available when at least one software breakpoint is set.

To open the BreakPoints List window, on the Windows menu click Soft Breakpoints.

The BreakPoints List window is as follows:

g
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. From the BreakPoints List window, you can perform the following operations:

DHEDDE

Ert:a_kF"ulnts Llst _ - | a
incpeet Doete | Shom Disabc ity

samplel : 119 ?

To do this:

Do this:

Set specific software conditions under which
a breakpoint is triggered.

Select the breakpoint, then click the Inspect
button.

Delete a breakpoint

Select the breakpoint, then click the Delete
button.

Display the selected breakpoint location
within the source code.

Select the breakpoint, then click the Show
button.

Enable/disable the selected breakpoint.

Select the breakpoint, then click the Enable/

Disable button.

4.10 Using Hardware Breakpoints

4.10.1 Hardware and Advanced Breakpoints

As a general rule, hardware breakpoints stop program execution when a specific hardware
event occurs. WGDBY7 provides you with various features that enable you to set hardware
breakpoints that cover a large number of situations.

These breakpoints fall into two main categories referred to in the following as:

Hardware breakpoints and Advanced breakpoints

Hardware breakpoints stop program execution when any of the following events occur:
» A variable or constant is accessed,

* A data memory address or range of addresses are accessed,

» A program memory address or a range of addresses are accessed,

* An opcode fetch occurs.

Advanced breakpoints stop program execution when any of the following events occur:
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« A stack overflow occurred,
* A stack underflow occurred,

* An external signal has been triggered in (Development Kit only).

4.10.2 Setting Hardware Breakpoints

To set a hardware breakpoint:

1 In the Windows menu, click Hardware Events
A cascading menu opens where you can select two other options:
» Hardware Breakpoints

» Output Triggers (option available only for the Emulator and the Development Kit, see
“Working with Output Triggers” on page 43).

2 Click Hardware Breakpoints

A Hardware Breakpoints window opens showing options that depends on the type of
device WGDB?7 is associated with: simulator, emulator, or development Kit.

This dialog box appears:
The upper box “Current Settings ” reminds you which Advanced Breakpoint options are set.
To change them, click the Configure... button.

For more information refer to “Setting Advanced Breakpoints” on page 40.

NOTE: The Advanced Breakpoints options are not available with the emulator.

The central box shows a list of hardware breakpoints already set.

3 Click the Add button.

The Hardware Breakpoint window extends, letting you access new setting buttons and
boxes:

4
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Hardware Breakpoints

" Current Settings
Stack underflow 7 overflow

slop
Configure. .. |

" Lizt of Hardware Breakpointz ™

#1 [0xf316-0xf3H) y NFETCH
#2 0xf2fb [4] y READ

Qeletel Add | Inzpeck >>»

"Event Range

@® To |0xf375 |

) Current location

' Whole variable

() Count OF Bytes @D

1] 4 Cancel |

[Hoze |

Help

_ )
" Mew Settings
jJ On X
From 04374 |

4 In the New Settings box, select an option according to the table below:

To stop program execution if: Select this:

The address being accessed is within the hardware breakpoint | Read/Write (Not On
range. The address must be a data address. Fetch)

The address of the instruction to be executed is within the On Fetch

hardware breakpoint range.

The specified area is accessed via a READ operation Read

(Not available with
the emulator)

The specified area is accessed via a WRITE operation

Write

(Not available with
the emulator)

4
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In the From field, enter the start address of the range for which the breakpoint is activated.
This can be expressed either as a variable (symbolic name) or as an address.

In the Event range box, choose the range on which the breakpoint is triggered:

Select To to enter the end address of the memory range on which the breakpoint is set.
This can be expressed either as a variable (symbolic name) or as an address.

Select Current location to activate the breakpoint only if the address defined in the from
field is accessed (range = 1 byte).

Select Whole variable to activate the breakpoint on the whole variable range which is
directly linked to the symbol type specified in the From field (for example on whole fields
of data symbols for a C struct data type).

Select Count Of Bytes to define the number of bytes from the location specified in the
From field for which the breakpoint is activated.

Click the OK button to set the breakpoint.

4.10.3 Setting Advanced Breakpoints

)

WGDB?7 with Simulator or Development Kit Only

g

B>

[N
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A2,

4

To set an advanced breakpoint:

In the Windows menu, click Hardware Events .
A cascading menu opens where you can select two other options:
* Hardware Breakpoints

» Output Triggers (option available only for emulator and development kit, see “Work-
ing with Output Triggers” on page 43).

Click Hardware Breakpoints .

A Hardware Breakpoints window opens showing options that depends on the type of
device WGDB?7 is associated with: simulator, emulator, or development kit.
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This dialog box appears:

The upper box Current Settings reminds you
which Advanced Breakpoint options are set.

To change them, click the Configure button.

A new dialog box is displayed for you to select
new breakpoint specifications.

You may specify any of these conditions:

» Stop upon occurrence of an input signal
(TRIGIN Signal option),

e Stop upon stack underflow,

m. Advanced Breakpoints Hi=] E3

" Stop upon :

TRIGIN Signal [™

Stack Underflow/0verflow X

Stack Overflow limit :

Help | Cancel

Hardware Breakpoint: [W[E E3

" Current Settings

Stack underflow / overflow
ztop
Configure._. |

" List of Hardware Breakpoints

#1 [0xf316-0xf36f) y MFETCH
#2 Oxf2fb [4] y READ

[elete |
Cloze |

Inzpect >>

Help

e Stop upon stack overflow,

» Stop upon stack overflow down to a
specified value of the stack pointer.

By default, the limit is the lower address of
the stack area for the current microcontroller.

Note that the TRIGIN Signal option is availa-
ble only if you run WGDB7 with the Develop-
ment Kit

(the option is greyed with the simulator).

Select an option according to the following table:

(574
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To stop program execution if:

Dp this:

evaluation board TRIGIN pin.

An external input signal is triggered on the

Check TRIGIN Signal
box.

A stack underflow occurs.

Check Stack
Underflow/Overflow
box.

A stack overflow occurs.

Check Stack
Underflow/Overflow
box.

values.

The stack pointer (SP) reaches a specified limit toward lower | Check Stack

Underflow/Overflow
box, and specify an
SP value in the Stack
Overflow Limit edit
box.

3 Click the OK button to set the breakpoint.

The information in the Current Settings box is updated according to the new Advanced Break-

point settings you specified.

4.10.4 Managing Hardware Breakpoints

You can perform all Hardware Breakpoint management tasks from the Hardware Breakpoints
window (refer to “Setting Hardware Breakpoints” on page 38). The table below lists the Hard-
ware Breakpoint management tasks you can perform and explains how to perform them:

To do this:

Do this:

Enable/disable a breakpoint.

Select the breakpoint from the List of
Breakpoints , click the Inspect button, then
click the On check box in the New Settings
box. When the On box is checked, the
breakpoint is enabled.

Delete a breakpoint.

Select the breakpoint from the List of

Breakpoints , then click the Delete button.
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4.11 Working with Output Triggers
4.11.1 Overview

@ Triggers are output signals that can be connected to an external resource from the
K‘&" £ Emulator or Development Kit. These signals can be used to synchronize an external
“;_/ measurement instrument, such as an oscilloscope. When the defined set of condi-

tions is met, an impulse (TTL level) is emitted or the level of a signal is changed at
the specified outlet:

AN

* On TRIGGER OUT 1 or 2 outlets on the emulator front panel, where a one-clock cycle
impulse is emitted.

* On a special outlet (TRIGOUT pin) on the evaluation board for the Development Kit. A spe-
cial dialog box lets you choose the waveform mode for the external signal (see “Setting the
TRIGOUT Mode” on page 46).

Associated events are referred to below as Trigger events .

You can set the trigger events so that the signals are sent under the following circumstances:
* When a variable or constant is accessed.
* When a data memory address or range of addresses are accessed.

* When a program memory address or a range of addresses are accessed or its contents
are executed.

* When an opcode fetch occurs.

4
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4.11.2 Setting Trigger Events

Output Triggers M= E3
v/~ TO seta trigger event: C i
A urrent Settings
A Mo Settings
Eonfigure:.. |
1 In the Windows menu, click Hardware
Events.

" List of Output Triggers
#1 [0xf400-0xF4FF) » TRIG1

A cascading menu opens where you can
select two other options:

e Hardware Breakpoints

» Output Triggers

2 Click Output Triggers

This dialog box appears: Velete |

The upper box “Current Settings” shows no ad-
. . . Cloze | Help
vanced settings for output triggers. This fea- ="

ture is not available for WGDB7 running with
an emulator.

Inspech >>

The central box shows a list of Output Triggers already set.

3 Click the Add button.

The Output Triggers window extends, letting you access new setting buttons and boxes:

4
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Output Triggers M= E3
T Current Settings " Hew Settings
L OREULEE Tigger OUT2 =] OnlX
Configure... |
From  [0xf500 |
" Lizgt of Output Triggers | " Event Range
#1 [0xF400-0xF46F) v TRIGT ® To |I]:-:f51[ﬂ |

) Current location

") Whole vanable

) Count OF Bytes @D

Qeletel &ddl Inspeck »> (1] 4 Cancel |

Eoze | Help

4 Inthe New Settings box, select a trigger event type:

For the Emulator , select Trigger OUT1 to output the signal on Trigger 1, or Trigger
OUT?2 to output the signal on Trigger 2.

For the Development Kit , select Force High to generate a high-level signal on the TRIG-
OUT pin, or Force Low to generate a low-level signal on the TRIGOUT pin.

5 Inthe From field, enter the start address of the memory range which, when accessed, will
cause a signal to be output. This can be expressed either as a variable (symbolic name) or
as an address.

6 Inthe Eventrange box, choose the range which, when accessed, will cause a signal to be
output:

Select To to enter the end address of the memory range which, when accessed, will
cause a signal to be output. This can be expressed either as a variable (symbolic name)
or as an address.

Select Current location to send a signal only if the address defined in the from field is
accessed (range = 1 byte).
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Select Whole variable to send a signal on if the whole variable range which is directly
linked to the symbol type specified in the From field (for example on whole fields of data

symbols for a C struct data type) is accessed.

Select Count Of Bytes to define the number of bytes from the location specified in the
From field which will cause a signal to be output when accessed.

7 Click the OK button.

The trigger event is now set.

4.11.3 Setting the TRIGOUT Mode

WGDB?7 with Development Kit Only

To choose the waveform mode for the external
TRIGOUT signal:

1 In the Windows menu, click Hardware
Events.

A cascading menu opens where you can
select two other options:

» Hardware Breakpoints Output Triggers

Click Output Triggers

This dialog box appears:

The upper box Current Settings reminds you
which TRIGOUT mode is set.

To change it, click the Configure button.

Output Triggers

" Current Settings

SIS E3

TRIGOUT Mode : Window

Configure.__ |

" List of Output Triggers

#1 (0xF400-0xf410) y FHIGH

Delete |

Inspect >>

Cloze |

Help

A new dialog box is displayed for you to select new TRIGOUT mode specifications.
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You may specify any of these modes:

* Pulse Mode

* Windows Mode

w. TRIGOUT Advanced Settings _ (O] ]
‘Mode | [ Preview
Pulse@ Foice HIGH Force LOW
Window O | | THEOMT i—| |
Ok Help | Cancel

In Windows Mode , the signal
generated by a Force High event
is a level transition from LOW to
HIGH.

Similarly, the signal generated
by a Force Low event is a level
transition from HIGH to LOW.

In Pulse Mode, only Force High
events cause a signal to be gener-
ated on the TRIGOUT pin. In this
case, the signal is a one clock cycle
impulse as shown in the picture op-

posite.

w TRIGOUT Advanced Settings Mi=] 3
" Mode [ Preview
Pulze D Foice HIGH Force LOG
Window® | | RSO —
Ok Help | Cancel

For example, setting the entry in a function as a Force High event, and the exit from the same
function as a Force Low event would enable you to control the full execution of the function on

the TRIGOUT pin.

4
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4.11.4 Managing Trigger Event Definitions

You can perform all trigger event definition management tasks from the Hardware Breakpoints
window (refer to “Setting Hardware Breakpoints” on page 38). The table below lists the trigger
definition management tasks you can perform and explains how to perform them:

To do this: Do this:

Enable/disable a trigger event definition. Select the trigger event definition from the
List of Output Triggers , click the Inspect
button, then click the On check box in the
New Settings box. When the On box is
checked, the trigger definition is enabled.

Delete a trigger event definition. Select the trigger event definition from the
List of Output Triggers , then click the
Delete button.

4.12 Working with the Trace Buffer

@ WGDB?7 with Emulator Only

The emulator trace buffer records hardware events that occur when a program is executed.
WGDB?7 enables you to view either all the trace buffer contents or filter those that you view.
You can also use the logic analyser to define up to three areas of memory, which when ac-
cessed either:

» Stop trace buffer recording after a specified number of cycles.
or

» Cause each access made to the specified area to be recorded a specified number of
times.

Each defined area of memory is called an event.
WGDB7 enables you to define up to three events, Event 1, Event 2 and Event 3.
Event 1 and Event 3 stop trace buffer recording after a specified number of cycles.
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Event 2 causes each access made to the specified area to be recorded a specified number of
times.

4.12.1 Viewing Trace Buffer Contents

1 On the Windows menu, click Trace.

2 The Trace window opens, displaying the events recorded in the emulator hardware trace
buffer. Source code is displayed in red, assembler code in blue, and all other lines are dis-
played in black:
£ trace M =] E3
Edit Helpl

[~ Hot ﬂeheshl Lnspectl {£ | < | » | >3 | thiunsl

200 v A&, ([_LEX.W]. X} -
0x2386 92DEDE 1D A, r[(0=de) W], X} 1D A, 0[(0=de) W], X3

201 LD [ SEX + 1).B, A

D=2389 B783 LD D=83. 4 LD D=83. 4

202 CALL [_SEX.W] ; Call main

Dx238b 92CDE2 CALL [¢0=xB2).T] CALL [(_SEX). W]

113 tor (3=0;:7++) A loop for ewer
Dz20a7 3IFAE CLE Ozas CLE J+1

Dx20a9 3IFAD CLE Dxad CLE ;|

Dz20ab CC2189 JEP D=2189 JEP D=2189

Dz2189 CCZ0AE JE Dz2laes JE Dz2laes

115 =tl++;

Dz20ae Ce0107 n A D=0107 1n A =t0+1

Dz20bl1 CE010& LD X.0=x0106 LD .=t

0z20b4 CEOL0G 1D X, 0=0106 1D X =tl J

From the Trace window, you can perform the following operations:

To do this:

Do this:

Set the window as Hot, so that its contents
are updated every time program execution is
suspended.

Click the Hot check box. When the Hot box is
checked, window is Hot.

Update the Trace window contents.

Click the Refresh button.

View the value of a constant or data.

Select the constant, variable, or register, then
click the Inspect button.

Display the disassembled code of a selected
address.

Select the address then click the Inspect
button.

View the source code of a selected function.

Select the function, its address or line
number, then click the Inspect button.

4
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Browse through the flow of the traced code. | Click the '<<', ">>' buttons to browse through
source code.

Click the '<', '>' buttons to browse through
assembler code.

Filter the displayed event types. Click the Options button, then select the
appropriate options from the Disassembly
options in the Trace Options window.

View source code, opcodes and operand Click the Options button, then select the
binary dump, hexadecimal operands of appropriate options from the Disassembly
disassembled instructions with variable options in the Trace Options window.
names each instruction cycle in the Trace

window.

NOTE: Setting this window as Hot reduces the WGDB7 performance for application load or
save. To update the display and save time, don’t use the Hot check box; use the Re-
fresh button instead.

4.13 Managing Trace Buffer Recording Using the Logic Analyser

@ WGDB?7 with Emulator Only

The logic analyser enables you to define up to three events, named Event 1, Event 2, and
Event 3.

Event 1 and Event 3 cause trace buffer recording to be stopped after a specified number of cy-
cles. Event 2 causes each access made to a specified area associated with the event to be re-
corded a specified number of times. This enables you, for example, to count the occurrence of
a complex event, or trace all accesses to an address or address range. If several event con-
ditions are set together (for example, Event 1 and Event 2), recording for an event condition is
only triggered when all previous event condition recordings are completed (for example, Event
2 condition recording only starts when Event 1 condition recording is completed). Trace buffer
recording is always done in the following order: Event 1, Event 2 then Event 3.

You can use any combination of Event 1, Event 2 and Event 3 with the following two excep-
tions:

« Event 3 cannot be used alone, Event 1 should be used instead.

4
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instead.

To define an event:

Event 1 and Event 3 cannot be used together without Event 2, Event 1 should be used

1 Onthe Commands menu, click Set Analyser .

The Set Analyser dialog box opens:

Stop execution : U

= SET ANALYSER
® o ® o ® Off
{3 On {3 On 3 On
EVENT1 EVENT?2 EVENT3
Gol | [ F-------- | | ...
¢--- Count1---» ¢--- Count2 ---» <--- Count3 ---»
cycles occurrences of event? cycles
oom ooo1 oom

Cancel I

2 Above the button associated with the event you want to define, select On. If you want to
stop program execution when trace buffer recording is completed, check the Stop execu-
tion box.

3 Click the button of the event you want to define.

The Event definition dialog box opens:
EVENT 1 E|
Address or $symbol Data
Voo [SLdote | o Al Set Al
Don't cae FWWFVMWFVMFFVMFVFFV [Reset| MVMVFVFFWV | Reset|
Probe Counter Cancel |
AL3 AL2 AL1 ALD 52 VMA R/W LIR
On rCcoro oo - r
e S
To set the event on an address or a symbol in the memory space, enter the address or
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the symbol name preceded by the $ symbol in the Address or $symbol Value field.

Don’t care check boxes indicate individual bits to be ignored in the address. The leftmost
bit is bit 15. To consider all bits, click the Reset button. By default, all Don’t care check
boxes are checked, which means that the entire address will be ignored.

To set the event on a data value in the memory space, enter a data value in the Data
Value field.

Again, Don’t care check boxes indicate individual data bits to be ignored. To consider all
bits, click the Reset button. By default, all Don’t care check boxes are checked, which
means that the value will be ignored.

To set the event on a signal value, check the appropriate check box for the signal whose
value you want to consider, according to the following table:

Check this box: To consider this value:

AL3 to ALO The appropriate input probe signal (binary)

S2 Probe S2

VMA Valid memory address

R/W Read/write memory access

LIR Load instruction register (fetch) memory access

If you want to set the event on any value, leave the Don't care check box checked for that
probe. If you want to set the event on the input of a signal to the probe, uncheck the Don't
care check box for that probe.

4 For Event1 and Event 3, by default, the trace records are recorded until the defined con-
dition is met, then for an additional one cycle after that. To continue recording for more
than one cycle, enter the number of cycles to be recorded after the event is met in the
Counter field.

5 For Event 2, by default, only one occurrence of the event is recorded. To record more than
one occurrence of Event 2, enter the number of cycles you want to record after the event
is first met in the Counter field.

6 Click the OK button to implement the changes you made.

g
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To begin trace recording use the Run, Continue or any other program execution commands.
Recording continues until the program is stopped by a breakpoint, the logic analyser, or be-
cause the Stop button has been clicked. When the execution stops, the data in the Trace win-
dow is updated if it is ‘hot’, otherwise you must press the Refresh button to update it.

If you execute the program in step by step mode, no trace records are recorded.

4.14 Pin Input/Output Simulation

WGDB7 with Simulator Only

&4

4.14.1 The Input-Process-Output Scheme

Simulating the execution of a program on an ST7 microcontroller would be quite frustrating if
you were not able to input signals and see the resulting output. The behaviour of a program
cannot be completely understood unless the occurrence of external events is considered. In-
put signals enter a black box (the simulated microcontroller) which in turn produces output sig-
nals after the program has been executed.

External information (pin stimulus) is conveyed through the simulated microcontroller pins,
configured as 1/O ports (or parts of /O ports). Some pins can be configured as input or output
and some are dedicated to only input or only output (see the ST7xxxx datasheets). The follow-
ing is an example of the ST72251 microcontroller pin configuration:

Table 2. Example of Pin Configuration (ST72251 MCU)

Pin No. : _
(SDIP32) Pin Name Type Description
4 PB7/SS 110 Port B7 or SPI Slave Select
5 PB6/SCK I/0 Port B6 or SPI Serial Clock
10 PB1/OCMP1_A 110 Port B1 or Timer A Output Compare 1
11 PBO/ICAP1_A /0 Port B1 or Timer A Input Capture 1
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Table 2. Example of Pin Configuration (ST72251 MCU)

(gggs?é) Pin Name Type Description
12 PC5/EXTCLK_A/AIN5 /10 Port C5 or Timer A Input Clock or ADC Analog Input 5

For more information on a specific ST7 MCU pin assignment, refer to the appropriate
ST7xxxx Datasheet .

4.14.2 How to Setup Pin Input Simulation

Pin Input Simulation File

To simulate pin input signals, the user must create a text file that includes pin input simulation
information. This text file must be saved as:

<filename>.in

where <filename> is any name complying with the usual naming conventions for Windows
3.1, 95, or NT.

It is advisable to choose for this name the name of the application to be simulated and to place
the file in the directory of the application.

Pin Input Simulation File Format

Three types of input signals can be simulated:
* Binary
* Analog

» Square wave cyclic

Each line in the file should follow the corresponding syntax (fields separated by one or more
spaces):

4
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Binary Signals

PIN <pin_name> -i <value> <start_time>
Where
<pin_name>

is the name of the pin. You can use any name (maximum 8 alphameric characters). It is
recommended to use port names as specified in the corresponding datasheet.

Examples: PB7, PCO, PA1

is the signal type for binary signals.

<value>
is a code for the signal at the time indicated next field. Specify 1 to simulate a rising edge.

Specify 0 to simulate a falling edge.

NOTE: At zero CPU ticks the signal is supposed to be low.

<start_time

is the time when the state transition should occur. Specify an absolute time in machine
cycles (CPU ticks).

Analog Signals

PIN <pin_name> -a <value> <start_time>

Where

<pin_name>
is the name of the pin. You can use any name (maximum 8 alphameric characters). It is
recommended to use port names as specified in the corresponding datasheet.

Examples: PB7, PCO, PA1
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is the signal type for analog signals.

<value>
is the value of the simulated analog input signal. Specify a value between 0 and 255.

<start_time>

Specify the absolute time in machine cycles (CPU ticks) when the simulated event (ana-
log signal) should occur.

Square Wave Cyclic Signals

PIN <pin_name> -c <init_value> <start_time> <period>
Where
<pin_name>

is the name of the pin. You can use any name (maximum 8 alphameric characters). It is
recommended to use port names as specified in the corresponding datasheet.

Examples: PB7, PCO, PA1

is the signal type for square wave cyclic signals.

<init_value>

is the starting level of the cyclic signal. Specify 0= low, 1= high.

<start_time>

is the time the state transition should occur. Specify an absolute time in machine cycles
(CPU ticks).

<period>

g
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is the period of the signal in machine cycles (CPU ticks).

Example of Pin Input Simulation File

File Name: example.in

This text file would contain, for example, these lines:

PINPA1-i00
PIN PA1-i 110
PIN PA1 -i 0 30
PIN PA1 -i 1 50
PINPA4-i00
PINPA4-i15
PIN PA4 -i 0 22

PIN PA3 -a 10 6
PIN PA3 -a 30 35
PINPA2-c1151

The example.in  file is just a line by line description of events occurring on the pins specified.

You may add or remove any lines in the file, thus modifying the script for the I/O simulation.
The pin names do not have to be in sequential order within the Pin Input Simulation File.

Loading the Pin Input Simulation File into a Waveform Editor would produce the following di-
agram:

4
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0 Cpu Ticks 10 20 30 40 50 60 64 Cpu Ticks
S R I [
PAd4 [
PA3 . .
1] 0 30
PA2 U L e

NOTE: The Pin Input Simulation File can also be created directly by the Waveform Editor. For

more information refer to the on-line help messages of the Waveform Editor you are
running.

4.14.3 Starting Pin Input Simulation

To start pin input simulation proceed as follows, assuming that you have already started the
simulation session:

1 Start your application via the Choose a File dialog box:

Choose A File |

Filter: (= absz:=.z19:=.gdb:*.in

- |

= & x|
== st7too~1 sample.abs -
—
e —_I
£ realtim o
£ spim11 __pI

2 Follow the instructions as indicated above in “Loading a Program” on page 29.

3 Using the same Choose a File dialog box load the Pin Input Simulation File (<filena-
me>.in file) that contains the script you want to execute.
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Specified values are automatically simulated as input on the specified pins when the
application is started.

NOTE: The order in which you load the application and the pin input simulation file is irrele-
vant as long as you are in the WGDB7 simulator environment. You may load the
<filename>.in file first as well.

4  Stop your application.

4.14.4 Pin Output Signals Generated by your Program

Naturally, as a result of the simulation process pin output signals are generated on output
pins.

Their characteristics are systematically recorded in a new text file, the pin output file automat-
ically saved and referred to as:

<filename>.out

where <filename> is the name of the corresponding pin input simulation file. This file is
named port.out by default. It can be found in the same directory as the pin input simulation
file.

The <filename>.out file has the same format as the <filename>.in file (with -o as the
common type for all pin output signals), and may be edited by any text editor.

4.14.5 Viewing Pin Output Generated by your Program

To display the output signals resulting from the simulation process use the Waveform Editor
that has been supplied with your simulator.

For this, click the Waveform Editor icon or select the corresponding menu in the cascading se-
guence on your Windows desktop.

NOTE: The name of the Waveform Editor file supplied with your simulator is grapher.exe ,
NOT waveform.exe.
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Within the Waveform Editor environment, click on the File menu, then click Load . Loading

<filename.out> into the Waveform Editor will produce a diagram as the example shown
below:
0 Cpu Ticks 10 20 30 40 50 1] 64 Cpu Ticks
S e | o
PA4 _l ________________ |
PA3 . ' '
1] 10 30
PA2 U U L A O
Pin Output 1 I | I | [
Pin OQutput 2 | |

This diagram is only a snapshot of the output pin behaviour as a result of the simulation proc-
ess. This information is not real-time and cannot be considered real-time.

NOTE: Input information (from the <filename>.in file) is systematically copied into the
<filename>.out file. So simulated input information and output values can be ex-
amined at the same time.

For more information on how to use the Waveform Editor , open the on-line help file provided
with the Editor.

4.15 Time Management

~i When using WGDB7 with a simulator, you can access features closely related to
time management.

4
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These features enables you to:

Time
» View the cpu time spent since the program to
be debugged was started (system time ), or System clack - 416863 cpu tick
the time calculated from an arbitrary origin you Stop after : [4294967295 | Reset|

specified (user time ), .
User clock : (4168632 cpu tick
 Set (or reset) program breaks based on

- g : d
elapsed cpu time. System time : |0 052108 seconds

Uzer time : () 052108 zeconds

To set a new time origin:
1 Onthe Windows menu, click Time. The Time window opens.

2 Inthe User clock field, enter the time origin in clock cycles (“ticks”) for the user clock. The
value in the User time field changes accordingly.

To set a time break:
1 Onthe Windows menu, click Time. The Time window opens.

2 Inthe Stop after field, enter the number of clock cycles (“ticks”) to be generated until a pro-
gram break is triggered.

To reset a time break:
1 Onthe Windows menu, click Time. The Time window opens.

2 Click the Reset button. The value in the Stop after field changes to a quasi-infinite value,
which means that no time break would occur.

4
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5 CUSTOMISING WGDB7

You can customise the following features in WGDB?7:

* The screen fonts.

The action taken when events occur.

1 Changing the Screen Fonts On the File menu,
point to Preferences, then click Screen Fonts .
The Font Preferences dialog box opens:

2 Select a new font type from the Name drop-down

list.

3 Select a new font size from the Size drop-down

list.

4 Click OK to implement the changes you made.

5.1 Changing the Colour Settings

. Color Settings E3

Current Line

— Dizplay mode for Breakpoint lines

Bold i+

Break Lines

Colored > |

— Dizplay mode for the current PC Line

Underlined +
PC Line

Colored T

ﬁesetl oK | Qancell Help |

breakpoint line in bold.

62/76

The breakpoint line, Program Counter line and currently selected line colours.

. Font Preferences
Font name: [ [oPeSmm
Font size: 9.75 j
T Test

Thi= i= the font.

Test label: This is the font.

(1] 4 Cancel

Help

To

change the breakpoint line, Program Counter
line and currently selected line colours and ap-
pearance:

1 On the File menu, point to Preferences ,
then click Color Settings .

The Color Settings dialog box opens:

2 To change the color of the current line

marker, click 221 next to the Current Line cap-
tion to list the available marker colours and se-
lect one.

3 Tochange the display mode for breakpoint
lines, in the Display mode for breakpoint
lines box :

iSelect the Bold button to display the current

4
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3

3

ii Select the Colored button then click to list the available marker colours and select
one for the current breakpoint line.

To change the display mode for the current PC line, in the Display mode for the current
PC line box:

i Select the Bold button to display the current PC line in bold.

ii Select the Colored button then click to list the available marker colours and select
one for the current PC line.

Click OK to implement the changes you made.

5.2 Selecting Which Events are Indicated

1

4

On the File menu point to Preferences , then Debug Options .

The Debug Options dialog box opens: R —.
Click the appropriate check box: dAnformation messages displayed; [
When the Information messages dis- Warning messages displayed [V
played box is checked, information mes- Source window opened on Stop [
sages are displayed. Information Beep on break event ™
m inform for example, when

essages Into you_’ O_ € a pie, whe S ave the default workspace ™
a Hardware Breakpoint is triggered or a
stack overflow occurs.

) ) 1] 4 Cancel Help

When the Warning messages dis-

played box is checked, warning mes-
sages are displayed. Warning messages indicate, for example, when required symbol
information is not available.

When the Source window opened on Stop  box is checked, the module window is dis-
played when program execution is stopped.

When the Beep on break Event box is checked, a beep sound is made when a break-
point is reached.

When the Save the default workspace box is checked, program workspace configura-
tions are saved when programs are closed (see next section).
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6 WORKING WITH WORKSPACES

Workspaces are made up of the following definitions relating to each program you load to
WGDBY7:

* Open windows.

*  Window positions.

» Software breakpoint definitions.

e Current cursor position in each module window.
* Window states (Snapshot, Hot or Real-time).

» Disassembly options.

» Trace options.

When you load a program, the default workspace configuration that you were using when you
last closed it is restored, thus you can continue working from where you left off the previous
time.

WGDB7 enables you to save a workspace definition, so that you can restore it at a later date.
It also enables you to enable/disable automatic default workspace saving, so each time you
close a program its workspace is saved.

NOTE: Since workspaces are directly linked to programs, you can only load or save work-
space configurations after the program to which they pertain have been loaded.

4
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6.1 Saving and Loading Workspace Definitions

1 On the File menu point to Prefer- — —

ences, then click Workspace . (W Workspace  H|
: Save the default work v
The Workspace dialog box opens: ave the default workspace ™

] —Workspace File
2 Toload a saved workspace settings

file: Directory :
) h:\cazal\zaveitestihicrossh.

i Select the file you want to load
from the list.

* WsC

it Click the Load button
To save the current workspace set-

tings:
g Save |

i Type the file name in the file
name box.

. . Ok LCancel | Help
ii Click the Save button.

3 Click OK to implement the changes
you made.

6.2 Enabling/Disabling Automatic Default Workspace Saving
To enable/disable automatic workspace saving when you close a program:
1 On the File menu point to Preferences , then click Workspace .
The Workspace dialog box opens.
2 Inthe Workspace dialog box, click the Save the Default Workspace check box.

When this box is checked, any workspace modifications you make are saved when you
close programs.
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7 USING GDB7 COMMANDS

WGDBY7 is a Windows interface to GDB7 commands (that is GNU and specific ST7 com-
mands). When you choose a WGDB7 menu option, button, or enter a field, WGDB7 executes
an appropriate GDB7 command. Using WGDB7, you can:

» Execute GDB7 commands when a program is loaded.
» Execute GDB7 command batch files.

» Enter GDB7 commands using your keyboard.

» View the GDB7 dialog executed by WGDBY.

* Record GDB7 command dialog in a log file.

The following paragraphs explain how to perform these tasks.

7.1 Executing GDB7 Commands When a Program is Loaded

When you load a program, WGDB7 executes either of the following files if they exist in the pro-
gram directory:

hardware.gdb
<program>.gdb

where <program> is the name of the loaded program. This enables you to create program-
specific commands each time you load a program.

You can create GDB7 files using any ASCII text editor.

Each command must be on a separate line.

For details about the available commands and their syntax, either type
help <command_name>

in the Console window or click GDB Commands on Contents page of the WGDB?7 online help.

7.2 Executing GDB7 Command Batch Files

Executing batch files can be useful for automatic test-driving programs and creating regres-
sion testing suites. You can create batch files of GDB7 commands that are executed without
the WGDB7 windows interface. An example of such a file is included with WGDB7, it is named
batch.gdb and is stored in the WGDB?7 installation directory (c:\st7tools ).

To execute this batch file, execute GDB7.exe in the WGDB?7 installation directory, with the ar-
gument:

-command=c:/st7tools/batch.gdb -batch
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7.3 Entering GDB7 Commands Using Your Keyboard

WGDBY7 lets you enter GDB7 commands using your keyboard. To enter GDB7 commands us-
ing your keyboard:

1 Onthe Windows menu, click Console .

The Console window now opens, enabling you to enter commands using your keyboard:

Clear | (¥ Verbose [X Log |[Browse| [C:\TEMPACONSOLE.LOG
(gdb7) d 144 [«
0x0090: 00000000, 8585505 90920057, 55432100
[gdb7)
~|
A Y

Click the first available line in the Console window.

Type the command, then press the Enter key. GDB?7 interprets the line on which the cursor
was when you pressed Enter. Therefore, to reissue a command, place the cursor on the
command, and press Enter. GDB7 repeats the last command if Enter is pressed on an
empty line.

Note that you can access help on GDB commands either by:

4

Typing help followed by the command name about which you want help in the Console
window, then pressing Enter

or

In the WGDB7 main window, clicking Help|Contents then choosing GDB Commands for
STMicroelectronics-specific commands

or

In the WGDB7 main window, clicking Help|GDB Commands for general GDB commands.
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7.4 Viewing GDB7 Dialog Executed by WGDB7
To view the GDB7 commands that WGDB7 executes:
1 Onthe Windows menu, click Console .
The Console window now opens.
2 Inthe Console window, check the Verbose check box.

You can now view all the GDB7 commands that are executed by WGDB?7 in the Console win-
dow and their results.

7.5 Recording GDB7 Commands in a Log Flle

WGDBY lets you record all the GDB7 commands that it executes and their results in a session
in a log file:

1 Onthe Windows menu, click Console .
The Console window now opens.
2 Inthe Console window, check the Log check box.

3 To create a new log file, click the Browse button and select the drive and folder you want
to create the new file in, then enter the file name in the File Name box.

4 To use an existing log file, click the Browse button and select the drive and folder contain-
ing the file, then select the file name in the File Name list.

You can also store input commands (the results of commands generated by WGDB7 and sent
to GDB7) and command outputs (those commands generated by GDB7 and sent to WGDB?7)
separately in files.

To record input commands, use the GDB7 command: set remotelogfile <filename>

To record command outputs, use the commands:

wfopen <filename>
where <filename> s the file to record command outputs in, and

wfclose

when you have finished.
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8 QUESTIONS AND ANSWERS

8.1 What does the hour glass cursor mean?

=
When the cursor appears as an hour glass (), this means that WGDB?7 is executing a com-
mand, or the program is running.

Note that you can click the WGDB7 Stop button to stop program execution and return the cur-
sor to its normal state.

8.2 Why is the Locals window empty?

This is either because you are debugging a macro-assembler application—macro assembler
language does not have local variables, or you are debugging a C-language application, and
the current function does not have any variables or parameters.

8.3 How do | specify the location of source files?

To find source files, WGDB?7 uses a 'source path' that works like the MS-DOS path feature: the
directories specified in the source path are read one after another until the file name is found.

By default, source files must be located in the same directory as the program file. If your
source files are in another directory or in several directories, you can use the directory
<pathname> command to the front of the source path.

You can specify several path names using the "; " separator. When used without parameters,
the directory command resets the source path to the current directory.

Example:
directory c:\tester\sources;c:\tester\library

You can put this command into the program startup file named <program>.GDB to automat-
ically set the path to the application source files (see “Executing GDB7 Commands When a
Program is Loaded” on page 66).

8.4 How can | modify a Hardware Breakpoint?

You cannot maodify the address or address range of a Hardware Breakpoint. You must delete
the breakpoint then and create a new one.

8.5 Why are some software breakpoints never triggered?

If a software breakpoint is not triggered when you think it should be, check that it is not disa-
bled in the BreakPoints List window (see “Managing Software Breakpoints” on page 36).
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8.6 Why are some Hardware Breakpoints never triggered?

If a Hardware Breakpoint is not triggered when you think it should be, check that it is not dis-
abled in the Hardware Breakpoints window (see “Setting Hardware Breakpoints” on page 38).

8.7 What does “Stop at user request” mean?

This message is displayed when you stop the execution of your program. If you do not want
this kind of message to be displayed:

1 On the File menu, point to Preferences, then click Debug Options.
2 Uncheck the Information Messages displayed check box.

Information messages will no longer be displayed.

8.8 How Do | execute WGDB7 from Winedit?

To execute WGDB7 from Winedit, enter the full wgdb7.exe path, and specify the same argu-
ment string as that specified by the WGDB7 emulator/simulator shortcut or icon.
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